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Introduction

1.1 Purpose and Functions

The EIA-176 Query System is a PC-based system for users to produce reports and
extract data from the EIA-176 database that is used to produce the Natural Gas Annual.
Its purpose is to provide users with company-level data. This information is available in a
format similar to the survey form for individual companies, as well as in files suitable for
tabular calculation.

The query system has two functions. e The first is to provide individual company
responses in a form that resembles the EIA-176 survey form. This is viewable on-line,
and available in a printed form. Appendix A shows a sample EIA-176 form. Each
respondent is available in the year they reported data on the form EIA-176.

e The second function is to provide files of EIA-176 data for use with other software
packages. The query system provides two methods to obtain tabular data. (1) a set of 24
pre-selected queries. The information in these queries was designed to satisfy the bulk
of data requests received by the EIA. Appendix B outlines the pre-selected queries and
their data items. And;

(2) The second method is for user-selected queries. These queries offer users the ability
to access sets of data items not included in the pre-specified queries. Appendix C
outlines the available data items. Data in the pre-selected and user-selected queries
includes adjustment entries made by EIA staff to ensure that EIA-176 and publication
data balance.

Data sets from both query methods can be saved to separate files in a variety of popular
formats that include: text, comma-delimited for spreadsheets, SDF files for use with
dBase, and fixed width format for use in other software packages.

New in the pre-selected query section is a report of Name/Address data, a report

detailing individual company items shown in the continuation pages of the form, and LNG
activity.
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1.2 Hardware and Software Requirements

The minimum hardware requirements needed to install and use the EIA-176 Query
System are:

eAn IBM-compatible personal computer (PC) — minimum Pentium 75 is suggested and 24
MB of RAM

eThe Windows operating system and Microsoft Office with MS Access versions 2000 or
later.

eAn 80-column monitor

¢15 MB of hard-drive space

* - See the ‘Getting Started’ document for notes about installing and using the EIA-
176 Query system with Access 2003 or Access 2007.

2.0 Installing the Query System
2.1 Installing the EIA-176 Query System

To install the EIA-176 Query System on your PC:

1)
2)

3)
4)

5)

6)

7
8)

Download the software from the EIA web site.

Open Windows Explorer and find the file. The name will depend on which version was
selected.

Double click on the file and follow the instructions.

As the installation begins, a ‘Welcome’ screen is displayed. Click the ‘Next’ button to
continue.

The ‘Select Destination Directory’ screen will be displayed. Click the ‘Next’ button if you
wish to continue the installation to the default directory. If you wish to change the default
directory, click the ‘Browse’ button.

The ‘Ready to Install’ screen will be displayed. To continue with the installation click on
the ‘Next’ button.

A progress bar will appear.

When the installation is completed the ‘Installation Completed’ screen will be displayed.

2.2 Starting the EIA-176 Query System

The query installation program creates a program group and a desktop icon for the EIA-176
Query System. The desktop icon starts the query system up immediately and appears on the
desktop after the install program runs.

2.3 Compressing the File for best performance

The program group, which is available through the START menu has the EIA-176 Query System
icon, as well as an uninstall option. A compress option is available from the File Menu within the
application.

The compress option should be run periodically so that the query database does not become
fragmented.
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I ElA-176 Query System
||File Edit Datasheet Ex

il Cloze Window/F epart
Save ba...
Expart...
Compact and Repair D atabaze. . iq
% Brirt...
[ I

Run the Compact and Repair from the File menu.

3.0 Using the Query System

After a successful installation you can use the query system to print off individual company
submissions or to generate data files from your Windows desktop by clicking the START button,
then the Programs button. If you are using Access 2003 or Access 2007 please see the “Getting
Started” document for a description of some warning screens you may encounter. Select the EIA
Applications items, and then click EIA-176 Query, and the Main Menu Screen of the query system
is displayed, as show below:

3.1 Main Menu

=S| EIA-176 Query System =B X

@9 Energy Information Administration

Official Energy Statistics from the U.5. Government

The most current ElIA-176 Query System
years data are:
1997
Izoog 1998 View EIA-176 Respondents
1999
Other 2000
Years ggg;
i : | uery EIA-176 Data
Available 2003 Query
2004
2005
2006
2007 | Exit
2008

Visit the EIA Natural Gas web site at:

hitp:t/ve v v eia.doe.govioil gas/natural gasfinfo glance/natural gas.html

Try the Natural Gas Navigator at:

http-/ftonto.eia.doe.gov/dnav/ng/ng sum fop.asp

The three main options available in the EIA-176 Query system are accessed via this menu. They are:
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2)

3)
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View EIA-176 Respondents: Click this to choose individual respondents and view or print their
submissions

Query EIA-176 Data: Click this to choose pre-selected or user selected queries which will allow the user to
save data to PC-compatible files

Exit: This ends the EIA-176 query.

Each option is described in the sections that follow.
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3.2 View EIA-176 Respondent
3.2.1 Select a Company

After clicking the View EIA-176 Respondents button on the Main Menu, the following Choose
EIA-176 Company Screen is displayed.

1) Select the report year first.
2) Select the retrieval method

E View EIA-176 Respondents - Choose Company(s) -

View EIA-176 Respondents - Choose EIA-176 Company(s)

Please enter a report year: 1997 =
You can port year: e
select one Choose a retrieval method 1999
or more ggg?
companies % Selecta Company in a State 2002
by name 2
or state . % Selecta Company by Name 2001
2005
2006
2007
2008 -
Use the
arrow o
buttons to View
selecta
state or i
company. Selections
=<=Back |

If you select a company by name you will see a list of EIA-176 company names. If you select a
company in a state you will get a list of states. The companies will appear after you select a state.

3.2.1.1 Select a Company in a State

If you Select a Company in a State you'll see a list of states

located in-

Highlight the state(s) you want and use the single right pointing arrow L
between the two white boxes to move the state to the selected box.

To unselect a state use highlight it in the selected (leftmost) box and use the single left

- 1
pointing arrow J to move the state out of the selected box.

Once you've selected a state click on the Select Company button to see available companies
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Select
Company

within that state.

Use the mouse to select the company you want to view in the Companies available box. Click the

right pointing arrow to move it to the selected box on the right.

3.2.1.2 Select a Company by Name

E Wiew EIA-176 Respondents - Choose Company(s) -

View EIA-176 Respondents - Choose EIA-176 Company(s)

Pl t t . 1998 -
You can ease enter a report year: 1999
select one Choose a retrieval method 2000
or more ggg;
companies “  Selecta Company in a State 2003
by name 2004
or state . ' Select a Company by Name 2005
2006
Select Respondent Name 2007

Companies Available Companies Selected -

AZ  |CLEAN ENERGY | EL PASO NATURAL GAS COM AZ

AZ  ELPASONATURALGASC Select
Use the AZ | GRAHAM COUNTY UTILITE ! Company
arrow AZ  |MESACITY OF : —

AZ MOJAVE PIPELINE COMP# >| [Add to your selection ist View ==
buttonsto /.7  navajo TRIBAL UTILITY A |
selecta AZ  |SAFFORD CITY OF ;l
state or AZ  |SOUTHERN TRAILS PIPELI _<| Print |
company. AZ SOUTHWEST GAS CORPC Salections

AZ | TRANSWESTERN PIPELINI

AZ  |UNS GAS INC

AZ  |\WILLCOX CITY OF = <=Back |

T > TN ol

El Paso Natural Gas has been selected.

3.3.2 View and Print EIA-176 Respondent Submission

YView =>

To view the submissions click the View=> button.

Print
Selections

To print the submissions without previewing it click the Print Selection button.

View Respondent result — Preview screen
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& view FIA-176 Company

WAL OMB No. 19050175
I kbrmiaa Expiration Date: 12/31/2008
s Version No.:2008.01
ANNUAL REPORT OF NATURAL AND SUPPLEMENTAL GAS SUPPLY AND DISPOSITION
FORM EIA-176

REPORT YEAR 2008
This report is mandatonyunder the Federal Ensngy Administration Aot of 1574 {Public Law 53-274), For the provisions concerning the
con fiden fislity of information and sanclions statements, s=& instructons.
Title 18 USC makes it a criminal offense for any person knowi ngly and willingly to make to any Agency
or Department ofthe United States any falsg fictiious, or fraudulent statements as to any matter within

its jurisdiction.
Part 1. RE SPONDENT IDENTIFICATION PART 2. SUBMISSION INFORMATION
| —
Entsr tha nams and malling & ddress To the company filing the ELL-1TE A completed form must be filed by March 1
EIAID Number Forms may be submitted using one of the
following methods:
Company Name: EL PASO NATURAL GAS CONMPANY
S Mail to: ATTH: ER-1TE
Operations in (State): AF

Energy Information Administration, EI-43
U.5. Department of Ene gy

P.O Box 8279

Sikver Spring, MD 20807

Email: O0G.SURVEY S{@eia.doe.gov
Fax:  (202) 386-1076

Secure File Trnsfer:
https:fiide.eia.doe gow/uploadinoticeoog.jsp

You can maximize the preview screen by clicking on the resize button in the upper right corner.

| MEES)

You can view subsequent pages of the preview screen by clicking the navigation buttons at the
bottom of the screen.

[Paga oL Il T il AT

The right pointing arrow > takes you to later pages.
The right arrow with the bar >| takes you to the last page.

The left pointing arrow < takes you to earlier pages.
The left arrow with the bar |< takes you to the first page.
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3.2.2.1 View EIA-176 Company Menu

The View EIA-176 Company Menu lets you control this display.
E: EIA-176 Query System

“ Exit O Page Setup... JO Sherint... £ Close

‘ Eadt — Closes this application.

B Pags SEtw'”_ — Allow you to choose a printer and set the page orientation (portrait works best).

2 — Changes the magnification of the report.

&5 Print...

L
] B Close _ Closes this report and either shows the next report if you've selected more than

one, or returns you to the Choose Company screen.

— Sends the report to the printer.

Once you've returned to the Choose Company Menu you can exit this function by clicking on the
<=Return button.

<=Return |

This will return you to the Main Menu.
3.2.2.2 Choose Company Arrow Functions

Below is a summary of what the arrow buttons in the Choose an EIA-176 Company

do:
Moves the highlighted item in the left box to the right box.
Move all the items in the left box to the right box.

H

I Moves the highlighted item in the right box to the left box.
14 Move all the items (highlighted or not) from the right box to

— the left box.
L
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3.3 Query EIA-176 Data
To view, select the Query Menu from the Main Menu.
There are two query options: Pre-selected, and User-selected.

ZE| Query EIA-176 Data - Query Menu

Query EIA-176 Data

Preselected Quer)er Menu
queries
create files
with
predetermined
EIA-176 items Pre-Selected

Queries

(see notes for available years)

Custom Queries

L

Custom queries
create

files with EIA-176
items that are
selected from a list

Back

L

The Pre-selected Queries option offers 24 queries that can be run on all or selected companies.
The queries and the data items they include are detailed in Appendix B.

The User-selected Queries option allows users to select other EIA-176 data items for inclusion
in data fields. They have a structured format. The rows will always be EIA-176 companies; users may
select column data values.

The following sections will describe these two options.

3.3.1 Pre-Selected Queries

Pre-selected queries are queries whose conditions have already been created. These queries save
the user the trouble of having to set the desired conditions each time he/she wishes to run the pre-set query.

The following pre-set queries are available:
Sorted by:
State
Volumes by sector (sales + transported)
Prices by sector
Rankings, by volume, national, and within States
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Type of Operations

Other:
Detailed data on continuation lines.

The first step in the pre-selected queries is to choose the year and company(s) you want to query.

3.3.1.1 Select a Company Screen

The Select Company screen for the queries is quite similar to that described in the View Respondent option
which is described in section 3.3.1.

Begin by selecting a year in the ‘Please enter a report year:” .

You can select EIA-176 companies to include in your queries. If you want all companies choose the Select All
Companies option, this retrieval method does not appear on the View Respondents menu. This will close this

screen and go to the select queries screen.

The same white boxes that were used in the view respondent data are used here. If you Select a Company in a
State you'll see a list of states to choose from.

Once you’ve made your selections click the Next=> button to select a query to run.

Next =>

EIA-176 Query System 11/18/09 - 12 of 41



EIA-176 Query System User’s Guide 11/18/09)

—3| EIA-176 Pre-selected Queries

Select a Query to Run 2008
You have Selected Years:
selected all
companies
Pre-selected Queries Query Description
Company Name Information This Query has the answers from
:Answers to Question in Part Il about Alternative Fuel V companies on Part 3. This data
«| § | All Respondent Type of Operations and Sector ltems is only available in 2005.

e All Part IV & V ltems (Volumes) |These are the available queries.l
;?3 All Part VI tems (Volumes, Costs)
AK Detail level Continuation Lines
AL Interstate Movement Lines (3.0 and 14.0)
AR Footnotes and Associated Data Values
AU LNG & Underground Gas Storage
AZ All Sector ltems (Volumes, Costs, Consumers)
BR =l All Sector items sorted by state

All Sector Prices

All Qortnr Wnle enrfad har cartnr LI

Query Units
— Count of how many alternative fuel
<= =
ST | I L | vehicles the company has.

A detailed description of each pre-selected query can be obtained by highlighting the query title. The description
appears in the box titled Query Description. The units the query will display in are shown in the Query Units box.

Once you've selected a query by highlighting it, click the Run Query=> button to execute the query.

Run Guery =>

The status bar is displayed at the bottom of the screen while the query is running. Some queries take a few
moments to be displayed.

A

The blue bars
show query
progress.

funning query |mm
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B9 UQPartvTotal_crosstab

0 0
0 0
0 1255267
0 0
0 0
0 32401533
0 32403818
0 953,818
0 0
0 17,929
0 0
78,182,385 0
0 31641250
0 337,475
0 794 495

Year - ST - COMPANYNAME - P4L0110Mc - P4L0120Mc - P4L0210Mc - P4L0220Mc - | P4L0230Mc - P4L0300Mc - P4L0400Mc ~ |1
AK  ADJUSTMENTPLCO 0 0 0 0 0
2008 AK ALASKA PIPELINE CO 0 0 0 0 0
2008 AK BARROW UTILITIES E 0 0 0 0 0
2008 AK CHEVRON USA INC 4572772 0 0 0 1]
2008 AK CONOCOPHILLIFS AL 7,673,099 0 0 0 0
2008 AK CONOCOPHILLIPS AL 0 0 0 0 928,679
2008 AK ENSTAR NAT GAS 0 0 0 0 0
2008 AK FAIRBANKS NATURAL 0 0 0 0 1]
2008 AK MARATHON QIL CO 54,811,598 0 599,489 0 0
2008 AK ROCKFORD CORPOF 1,584 852 0 0 0 0
2008 AK UNION OIL CO OF CGAl 24 916,774 0 0 0 0
2008 AL ADJUSTMENT P LCO 0 0 0 0 1]
2008 AL ALABAMA GAS CORP 0 0 0 976,989 0
2008 AL ALEXANDER CITY MUI 0 0 0 0 0
2008 Al ATHENS GAS DEPT C i 0 0 0 0

| Record: M 10f1930 *» M | Y Search | 4] il |

Query output is displayed in a grid on your screen.

3.3.1.3 EIA-176 Query Menu Functions

Menu items at the top of the screen are used to filter output, or export to other data formats.

2, Microsoft Access

“ File Edit Datasheet Tools Exit

File

" File Edit Datashest Tools Exi

ﬂ Close windowReport

Close Spreadsheet

&P Print...

Exit

Save As/Export Dakafile
ol Page Setup...
& Prink Presiew

|

Close — Closes the query grid.

Save As/Export —Saves the data to another file
Page Setup — lets you choose print settings

Print Preview — Shows what a printout will look like
Exit — Quits the Query system.

Close — Exits the select query window.
Save As/Export - option opens an intermediate box.

Note: This options works differently depending on the version of MS Access that you are using.
With Access 2007 you will need to “select all” and copy the grid to another application. Under
Windows XP and Access 2002 the Export screen will look as follows:

EIA-176 Query System
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E= EIA-176 Pre-selected Queries

J Cmlmemt = Muasmeir o Do I aNNnK
Company|D COMPANYNAME 8T YEAR | ResvolMcf | TRVolhicf | Comvolmef | Comt

[ > [176999994G  ADJUSTMENT PLCO | AG 2005 i 0 0
| |176020034K  BARROWY UTILITIES ELE| AK 2005 219,012 0 347 085 B
[ 176020094k | UKPIK MECHANICAL LLT AK 2005 0 0 1,357 281 13
| [17B02016AK | ALASKA PIPELINE CO | AK 2005 i 0 0
AR O = P E port Query ‘Qiy_AllCon_1* To... x| 340
: 1;2}?2332? EHI?ER\?-RFE Save in: I.: QueryCOutputs j @ - ._.ﬁ Q I Ll j ~ Toals ~
[ [17617845AK  [UNION C L\%

17619863AK | COMOCH

17622751AK | CONOG( | M Recent 3

Documents

1769526541 | FAIRBAI 6,0
1/B99395AK. | ADJUST
176000454 | FLORAL
176000454 | WEST Jl

%'\
L; =\l
® a@
=

| [176001359AL | ALABAN 1311
| [17600141AL ENERIDI
| [17/600162AL ALEXAN | py Documents 17
PSS I | — 78
- - i 77 —
Ch = industri: :1}5
Footnot | my Computer
Elnctrie _
.Eg File: name: Iqry_allmn_l j [ Save Formatted
I¥ly Metwork, I Autostart r—
< Places Save a5 bpei [uicrasoft Excel 57-2003 = LEEIL ic fe

Next you will be presented with a Windows dialog box. Headers may look better when you select
Save Formatted.
You can put your own name into the File Name box.

g=8 Qry_AllCon_1 : Select Query

CompanylD COMPANYNAME ST ResVol ResCost ResConsumers
| P [176020034K BARROW UTIL & ELEC COOP INC | AK 221,51 5145100 1132
I A =R V] S ave Query Qry_AlCon_1" In___ [ %]
17E02016AK. ALY - : :
" [17e02017aKk  Eng Saveint [ Exportecies E| = &l o=l

| 17613300 AK WA, MewGashct, xls ENewGasActI.xls @er_ConPrice_ﬁ.xls @UQWPS Expart I

| |17617544AK  CHI MewGastckE, xls ﬁNewGasActJ.xls ﬁer_ConRank_S.xls Cancel
ancel |

| |17817545AK [ UNI MNewGasictC, xIs ﬁNewGasActK.xls ﬁer_ConRankST_S.xls
176198634K. PHI MNewGasackD, xls ﬁNewGasActL.xls ﬂer_ConSrtSec_Z.xls
] 17622751 4K AR MewGasActE., xls ENewGasActM.xls @er_(:ontinuations.xls
B 1760004841 FLC MewGashckF, <ls ﬁNewGasActN.xls ﬁer_nma_?.xls Ltted

1760004941 WWE MNewGasickG, xls ﬁNewGasActO.xls ﬁer_Prod_CstS.xls
17E00130AL  ALs [° |NewGasActH.xls S Qry_ConCT_4.xls ‘F?TUerMLxIALL.xls

| |17E0m41AL M & | [oave———

Autostart

| [17B00TB2AL - ALE Text files may save more successfully by

— 13????18’”- AI" checking the Save Formatted box.
Record: 14| 4] If you save Excel files with this option the
’ : = headers look nice when you open the file
File narme: IQW_P."CDH_I Jxls _I in Excel.
Save as bype:  ERIRE A i

If you get the message EXTERNAL

Mot all file types are installed by default. To add ather file types, rfn the TABLE ISN'TIN EXPECTEP FORMAT
#Access, Change Option. Additional file bvpes are also available infhe OFfi]  click the Save Formatted option.

/

Different file type options are available by pulling down the ‘Save as File Type’ list box as shown.
By scrolling down the list of available file types you can choose dBase formats also.
Once you’ve named your file and selected the file type to save as click the Export button to finish

EIA-176 Query System 11/18/09 - 15 of 41
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the operation.

Page Setup
This option lets you set print settings and page orientation.

-

= Qry_AllCon_1 : Select Query

CompanylD COMPANYN Marging 1 Page | ;Cost |ResConsumery
’_ 176020034K  BARROWY UTIL & ELE 14,510.0 1,132
| |176020004K  UKPEAGWIK ARCTIC|  [-Margins (inches) 0.0 0
_ | 17B02018AK  ALASKAP L CO Tap: |1" 0.0 0
176020174AK  ENSTAR NAT GAS C( 8595870 90,117
_ | 17613300AK  MARATHON OIL CO Bottom: Il" 0.0 0
17617544 4K | CHEVROMN USA PROI 0.0 0
_|176175454K  UNION OIL CO OF c4 | e i 0.0 0
176198634K  PHILLIPS ALASKA N; 0.0 0

— Right: Il"
| 1TBZ22T51AK. ARCO ALASKA INC 4 0.0 0
_ | 17600048AL FLORALA GAS DEPT 331700 542
_ | 17600049AL WWEST JEFFERSON (' W Print Headings 48,993.0 520
_ | 17600139AL ALABAMA, GAS CORF 19,088.0 430,069
_ | 17600141AL MIDCOAST INTERST: 0.0 0
Record aaf <0 1 v lmle]of 1782 T T

<=Return [
Ok I Cancel |

Most query output looks best with the print orientation Landscape. This can be selected from the
Page tab.
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Print Preview

i Qry_AllCon_1 : Select Query

Page: |4|<| 1 p|>||
The Print Preview buttons lets you see what the printout will look like.
Print

The Print button prints the grid off. Some of the queries may be large.

I B ElA-176 Pre-selected Queries
e

2 Qry_AllCon_1 : Select Query

CompanylD COMPANYNAME ST ResVol Res
L 1760200348K  BARROW UTIL & ELEC COOP INC AK 221,971 5
| [ 17602009AK  UKPEAGVIK ARCTIC SLOPE A ]
1760201648K  ALASKARP L CO Al i
: 176020174AK  ENSTAR NAT GAS CO 56 5t
| [ 17613300AK  MARATHON OIL CO Mow printing page 3 of
| [17617544AK  CHEVROM USA PROD INC ‘Qry_allcon_1' to the
| [ 17617545AK  UNION OIL CO OF CALIFOI
| [ 17619863AK  PHILLIPS ALASKA NAT GA EPSON Stylus Photo on LPT1:
| [ 176227T51AK  ARCO ALASKA INC =
| |17600048AL FLORALA GAS DEPT 1:
| |17600049AL  WWEST JEFFERSOM GAS SYS AL 25 B53 2
| |17600139AL  ALABAMA GAS CORP AL 27 B2T.365 0 2587
176001414 MIDCOAST INTERSTATE TRANS I AL ]
Recar‘d"mr‘_“‘.p.pﬂ of 1782 <| 3 |

=T ———r—r—— T—r T — ———————— T
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To use the Copy option the grid or column needs to be highlighted. The entire grid can be
highlighted by clicking in the upper left corner (circled). Individual columns can be highlighted by
clicking in the column header.

To use Find, select just one column by clicking on the column header. The ST column is
highlighted in this example.

File | Eclit Datasheet Tools Exit

[k Bacopy ciec FEBx i o A @ AEH RV (A% BEA- B
#M, Find Next
Pee. | =
CompanylD COMPANYNAME ResVol Res
Click in the i 1760200348K | BARROW UTIL & ELEC COOP INC 221,971 5
ﬁ:;cr']‘ﬁ;ﬂt the [ 176020094K | UKPEAGYIK ARCTIC SLOPE 0
entire grid. [ 176020184K |ALASKA P L CO 0
[ T7602017AK  |ENSTAR NAT GAS CO 15756589 58,5
[ 176133004K  |MARATHON OIL CO 0
[ 17617544 4K |CHEVROMN USA PROD INC 0
{ 176175454K |UNION OIL CO OF CALIFORMIA, 0
: 176198634K  |PHILLIFS ALASKA NAT GAS CO 0
[ 1TB2275148K |ARCO ALASKA INC 0
K 176000484L  |FLORALA GAS DEFT 21,680 1

With the column selected puII down the Edit menu and click on the Find option.

=f Qry_AllCon_1 : Select Query

CompanylD COMPANYNAME ST ResVol ResCost F
|| 176183001N OHIO WALLEY GAS INC I 440,343 2,850,052.0
|| 17619004 1N REMSSELAER GAS UTIL DEPT I 248,028 1,381,0730
|| 176190191N POSEYVILLE MUN GAS CO I 29,650 2523860
|| 176190241 WESTFIELD GAS CORP [ 103,846 8674270
|| 17619633IN TEXAS EASTERN TRANS CORP | IN 0 0.0
|| 17619807IN SWITZERLAMD CTY MNAT GAS CO N 49 851 378,354 .0
|| 17619892IN BAINBRIDGE MUN GAS I 25 260 2035850
| | 176199121 NAPOLEOM TOWYN OF [ 13,684 98,340.0
|| 17619913IN COMMUNITY MAT GAS CO INC [ 481,939 3571,058.0
|| 17630608IN NAT GAS P L CO OF AMERICA, [ 0 0.0
|| 17684105IN SIGCORE ENERGY SERVICES [ 1] 0.0
|| 17684713IN YECTOR PIFELINE [ 0 0.0

P 117600032KS  ABBYVILLE CITY OF @ 4515 25,3950
T S| e 1 ) -
Consumptmn ol
e imeeaiee v e Find WhSE: IKS
<=Ret Search: IAII 'l I Match Qa.se Eind Mext |
™ Search Fields &s Formatted
Match: Whole Field ¥ Search Only Current Field Close |

A dialog box will appear. Enter the value you wish to search for. After you’ve centered the value
you want to find click either Find First, or Find Next. The grid will advance to the found value or tell
you that no values exist.
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Datasheet

Datasheet Tools Exit

[ A Eont..
i [0 Freeze Columns
" 2] cort Ascending
Z 1 sort Descending
W acvanced Filter/Sort..,
T_ apply FilterjSort
B Remove Filter/Sort
I ERGEELEEI

=T

Font - adjusts the type in the grid

Freeze columns -makes the frozen column

always appear

Sort Ascending/Descending - sorts the data in

the grid by the selected column

Advanced Filter - lets you enter some simple
criteria for data in the query.
Apply Filter - is used in conjunction with

Advanced Filter

Remove Filter/Sort — removed the Applied

Filter

Datasheet items allow you to manipulate the query that you’ve run.

The Font menu item changes the font of the data in the grid.

=g
COMPA ont EHE
JWALLEY G, E Font style: Size:
ISSELAER G, |BE _ [Regular |10 o |
SEYVILLE ML Regular
- . | arial Black =1 |italic 11 Cancel |
STRIELD GA: T Arial Marrow Eold 12 J
AS EASTER! | B BakerSigret Bald Italic 14
ITZERLAND ¢ |& pellGathic 16
B BellGothic Black 18
NBRIDGE ML B Bernhard Modern Rormilx | =] |0 =
'OLEON TOW
AMUNITY MAT —Effects —Sample
GAS P L CC
YVILLE CITY I@i 5
= o o Black - Script:
—I—I—I_.—’ il ] of 17 |Western j

nption Vals for

[ S W P P -

<=Return

This is a TrueType font, This same font will be used on both

your printer and your screen,

2.0
73.0
£6.0
7.0
0.0
4.0
85.0
0.0
9.0
0.0
0.0
0.0
85.0

In this example, selecting Bold turns all the items bold.
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l &' Qry_AllCon_1 : Select Query

CompanylD COMPANYNAME ST ResVol

| |17618300IN OHIO VALLEY GAS INC IN 440,343
| |17618004IN RENSSELAER GAS UTIL DEPT IN 246,026
| |17618018IN POSEYYILLE MUN GAS CO IN 29,650
| |17618024IN WESTFIELD GAS CORP IN 103,846
| |17618633IN TEXAS EASTERN TRANS CORP IN 0
| |17618807IN SWITZERLAND CTY NAT GAS COIN 49,851
| |17619892IN BAINBRIDGE MUN GAS IN 25,260
] L 17619912IN NAPOLEON TOWN OF IN| 13,684
| |17618913IN COMMUNITY NAT GAS COINC  IN 481,939
| |17680608IN NAT GAS P L CO OF AMERICA IN 0
| |17694105IN SIGCORE ENERGY SERVICES IN 0
| |17694713IN VECTOR PIPELINE IN 0
| |17600032KS  ABBYVILLE CITY OF KS 4,515
Record: 14 4] §13 o mDefof 1792 T 4] 1 .

The Freeze column options lets you always display one column on the screen.
To freeze columns place your cursor in the column you wish to always view. In this example that column is

COMPANYNAME.

COMPANYNAME ST CompanylD ResVol ResCost R
’_B/—\ ROWY UTIL & ELEC COJR INC | Ak 17602003AK 221,971 514.510.0
| |UKPRQGYIK ARCTIC SLO AR 176020084k 0 0.0
| |ALASKA Al 176020164K 0 0.0
| |ENSTAR NAT GAS CO A 176020174K 15,756,580 5658595870
| |[MARATHON OIL CO Al 1761330048k 0 0.0
| |CHEWRON USA PROD INC Al 176175448k 0 0.0
| |UNION QIL CO OF CALIFORNIA | AK 17E1T54 58K 0 0.0
| |PHILLIFS ALASKA NAT GAS CO - |AK 17619863AK 0 0.0
| |ARCO ALASKA INC Al 1IB22751AK 0 0.0
| |FLORALA GAS DEPT AL 17600048AL 21,680 1331700
| |WWEST JEFFERSON GAS SYS AL 17600048481 25,653 248,992 0
| |ALABAMA GAS CORP AL 17600138481 27 627,365 2587190880
| |MIDCOAST INTERSTATE TRANS INAL 1780014 1AL 0 0.0
Recard 1] ][~ 1 > impefof 1792 a i T
Pull down on the Datasheet menu item and click Freeze columns.
EIA-176 Query System 11/18/09 - 20 of 41



EIA-176 Query System User’s Guide

11/18/09)

Es EIA-176 Query System
“ File Edit | Datasheet Tools Exit

8-

E A Font..
I Freeze Columns
%l Sort Ascending
| El Sork Descending
W advanced Filker/Sort. ..
M ¥_ apply Filter/Sart
% "B Remove FilkerjSort

The COMPANYNAME column always

appears at the left. Even when scrolling to the
right, COMPANYNAME stays on the screen:

&' Qry_AllCon_1 : Select Query

- COMPANYMNAME ComCost |ComConsumer| Othe
LBARROW UTIL & ELEC COOP INC 756 030 215
| |UKPEAGYIK ARCTIC SLOPE 507 003 3
| |ALASKAF L CO 0 0
| |EMNSTAR NAT GAS CO 21445 075 12,420
| |MARATHOMN OIL CO 0 0
| |CHEVROM USA PROD INC 0 0
| |UNION OIL CO OF CALIFORNIA, 0 0
| |PHILLIFS ALASKA NAT GAS CO 0 0
| |ARCO ALASKA INC 9,296 911 25
| |FLORALA GAS DEFT 1,305 4
| |WWEST JEFFERSON GAS SYS 25,3266 22
| |ALABAMA GAS CORP 78,594 955 33822
| | MIDCOAST INTERSTATE TRANS M 0 0

Record: 1] || 1 v w[ef of 1792 i S |

Columns can be ‘unfrozen’ only by exiting the query grid.
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_Qatasheet Tools Exit
[ i o|e e sEl vE e Ba-

i [ Freeze Columns
1a]

Sort Ascending

Z
2| Sort Descending -‘
T advanced Filter/Sort, ., COMPANYNAME Re:
¥_ apply Fitter/Sort ROW UTIL & ELEC COOP INC AK 22101 ;
W, Rernove FilterSort EAGYIK ARCTIC SLOPE A
| [ 1/802016AK  |ALASKAF L CO Ak
| [ 17802017AK | ENSTAR NAT GAS CO Ak 56.%
| [ 17813300AK | MARATHON OIL CO Ak
|| 17817544AK | CHEVRON USA FROD INC
|| 17817545AK (UNION OIL CO OF CALIFORMIA
| |176819863AK | PHILLIFS ALASKA NAT GAS CO
|| 17B22751AK | ARCO ALASKA INC
| |17600048AL  |FLORALA GAS DEFT
| |17600049AL WEST JEFFERSON GAS 5Y5 :
| |17800139AL | ALABAMA GAS CORF 2587
| 1780014140 | MIDCOAST INTERSTATE JRANS IMAL

Record: | f[~ 1 wimpefofi7ez /4 " |

To use the sort éécending feature select a column by clicking on the column heading. Pull down the Datasheet
menu and click on Sort Ascending. The query will be sorted according to the values in the selected column.

2! Qry_AllCon_1 : Select Query

CompanylD COMPANYMNAME ST ResVol
P 117680806TX  PANENERGY TEXAS INTRASTATE TX ﬂ
17694747MN0D  ALLIANCE PIFELINE N 0
17692405FL  SOUTHERNMN MNAT GAS CO FL 0
1769232711 SOUTHWEST GAS STORAGE CO L 0
17692326M| SOUTHWEST GAS STORAGE CO M| 0
17690603MO KM INTERSTATE GAS TRANSLLZ MO 0
17690514 CA  ZPN PIFELINE COMPAMNY CA, 0
176905060 DESTIN FIPELIME O LLC hS 0
17692726MNM  PINMACLE NATURAL GAS CO MR 0
17681218AR  OZARK GAS TRANS LLC AR 0
176927240 SEMCO EMERGY PIFELINE M| 0
176806197 LOWER COLORADO RIVER AUTHC TX 0
17680617LA  JEFFERSOM ISLAND STRGE & HU LA 0
Record 140 <11 1 »imbslof17az "~ «i™ | ”

In the example above the ResVol values are sorted in ascending order, starting with zero.

Sort descending works the same way.
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g=! Qry_AllCon_1 : Select Query

CompanylD COMPANYNAME ST ResVol

’_ 17621931C4A SOUTHERM CALIFORMIA GAS CO (CA 751 44
_ 1761032210 MNICOR GAS IL 221 009 522
_ | 1TEI0617CA PACIFIC GAS & ELEC CO CA 211,181 852
| 1TE1T183MI COMSUMERS ENERGY O bl 176,663 600
_ | 17609432MI PMICHIGAN CONSOL GAS CO bl 136,124 328
__|17611456MN)  PUB SYC ELEC & GAS CO M 132 811,115
| 17ET03170OH  EAST OHIO GAS CO OH 131,187,521
__ | 1761096011 PEOPLES GAS LT & COKE CO 103 856 141
| 17601565NY  KEYSPAMN ENERGY DEL CO 29 463 564
| 17611459C0 PUB SVC CO OF COLORADO 86 738,306
| 176162350H  COLUMBIA GAS DIST CO 78312118
| 17E17436TH THU GAS DISTRIBUTION 75 700,297

L 17622738MN RELIANT ENERGY MINNEG O MN 68 957,997

With sort descending the largest values appear first.
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_Qatasheet Tools Exit
| A Font.. e esiilYav e xBa B

§ [ Freeze Columins
" &1 sort Ascending
Z 1| Sort Descending
J Advanced Filker /Sort. ..
Y_ apply FilterjSort

COMPANYNAME ResVol
ROW UTIL & ELEC COOF INC Ak 221,971

ResCost
5145100

ResConsumeryj CommVol
1,132 337816

WK Remove Fiter/Sort EAGYIK ARCTIC SLOPE AR 0 0.0 0 1,465,764
[ [17802016AK  ALASKA P L CO Al 0 00 0 0
| [17B02017AK  ENSTAR NAT GAS CO AR 15,756,589 56,585,987.0 90,117 5,698,403
| |17613300AK MARATHON OIL CO AR 0 0.0 0 0
| 178175444k CHEVRON USA PROD INC AR 0 0.0 0 0
| [17817545AK  [UNION OIL CO OF CALIFORMIA — AK 0 00 0 0
| [176198634K  PHILLIFS ALASKA NAT GAS CO AK 0 0.0 0 0
| [17622751AK  (ARCO ALASKA [NC AR 0 0.0 0 7,099,290
| |17800048AL FLORALA GAS DEPT AL 21,880 133,170.0 542 212
| [17600049AL WEST JEFFERSON GAS 5YS AL 25,653 248,993.0 520 3,779
| |17600139AL  ALABAMA GAS CORF AL 27,627,365 258,719,088.0 430,069 9,747,205

176001414 MIDCOAST INTERSTATE TRANS IM AL 0 0.0 0 0

Record. 14[ <] T piDjef17e2 T T A | o I]

To use the Advanced filter option no rows need to be selected. Just pull down the Datasheet menu and click on
the Advanced filter option.

The filter design window will appear.

g=! Qry_AllCon_1Filter] : Filter This window can be resized by
r———————— stretching the edges.
Gry_ AllCon_1

*

1) The first step is to copy the field
you want to search from the field

CarmparryIC L o .
pery list into the criteria grid.

COMPAMYRAP
aT <

Rl ;I

an either drag the name of
the column you want to search or
sort by in the upper pane of the

|

' — window into the criteria grid in the
Figld: (] < lower pane of the window, or
Sart: double click on a field to copy it to
Criteria: the next available field cell in the
i grid.

4 |

8 Qry_AllCon_1 : Select Query

__| CompanylD COMPANYNAME ST ResVol FR| CommVol |[C|Cor OtherNugsyol
'l Y CALERA CITY OF AL 57 665 12 20,917 5 10 1,688
. |17618576AZ  SOUTHWEST GAS CORP AL 26,148,540 14 20,419,530 3 '29 3,832,109
__|17608584CA  LONG BEACH CITY OF CA 5,183,814 16 2.103,854 4 011 313244
__|17610617CA  PACIFIC GAS & ELEC CO CA 211,181,852 19 58,646,965 3 148 660,992
__|17610644CA  PALO ALTO CITY OF CA 1,366 627 13 1,363,762 7 '56 24,941
__|17602792CT  YAMKEE GAS SVC CO CT 13,298,447 10 7,237 666 3150 241 615
__|17612046FL INDIAMNTOWMN GAS CO FL 17,798 11 11,219 1 | 29 685,174
_|17613084GA  HOGANSVILLE CITY OF GA 69,909 13 14,157 13115 2016
_ 1760816414 LAMOMNI hUMN UTIL 1A 62,140 10 26421 7 08 1,961
1761904814 ROLFE MUN GAS SYS 1A 30,306 19 9,553 3 | 41 4,492
__|17608308IL ILLINOIS PWR CO IL 336842111108 14,213,085 |5 328 1,964,110
_|17621016KY  RICHARDSVILLE GAS CO Ky 386751189 6,049 3 7 2555

176E16558MA  BAY STATE GAS CO [N 23,083,858 14 5,339,596 7 104 137 634

Record: 1] <] 1 > |l of 37 (Fitered) 4 |

[

[ [ [
Eiald: [ i ial [I=T I | | |
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2) By clicking on the Field column in the lower pane
you can get a list of fields in the query.

gzt Qry_AllCon_1Filter1 - Filter

Qry_AlCon_1

*

CompanyID
COMPAMYMNAR
aT

Ryol ;I

<« |

Field:

Sart: |[ Qe AlCan_1. )
Criteria: || Comparyl D 'l
or. | COMPANYHAME —
ST
Rfal
RCost
RConzumerz
Cval
|
3) In this example .
. Field:
Field: | Bal we’ve selected the SI?:.rt- Aol
Sart; = RVol field Criteri :
| = _ : ribenia; | =30000
aitenia: || Ascending You can pull down o L

or: || Descending
[t zarted]

4 |

the sort cell and
specify a sort order
if you want.

4) In the Criteria cell
we’ve entered a
condition that Rvol
be greater than
900000.

Datashest Tools Exit
| A I [
([ Freeze Ealimmns
: %l St Becending
l El Sork Descending
W &dvanced FilkerfSort. ..
apply Filker'Sart

. Remove FilkerSort

5) Click on the
Apply/Filter Sort
toolbar button when
you're ready to apply
the filter. Any records
that don’t meet the
criteria you specified
will disappear from
the view. They have
been filtered out. If
you click on the
Remove Filter/Sort
button they will
appear again.
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COMPANYNAME | 5T | ResVol
1 NAT GAS CO AK 17 418,738
A GAS CORF AL 26 272 B2a
JALLE MAT GAS DEPT AL 1,791 406
ZAST ALABAMA GAS DIST AL 172902
. GAS SVC CORP AL 4042 B43
IATED MAT GAZ CO AR 1,232 041
SAS WESTERM GAS CO | AR BB10,113
AL ORLAHOMA GAS COFAR 2970 k24
T EMERGY ARKLA, AR 25180 914
JTY OF AT 1,024 299
NEST GAZ CORF AL 24 913 465
o UTIL ARIZOMA GAS DI Y AL 5 527 Ba8
EACH CITY OF CA, B BE3 055
» GAS & ELEC CO CA 234,195 443

6) The rows that appear should meet the criteria. A note: on full survey datasets it helps to have plenty of
memory available. If you run a filter and nothing changes you may not have enough memory to process.

If you have enough memory, you are not limited to one field or value. You can select several fields in the
criteria grid. The EIA-176 Query system offers standard operators

= Equals

> Greater than

< Less than

>= Greater than or equal to
<= Less than or equal to
<> Not

To specify AND/OR criteria place the operators in different rows of the criteria grid.

Field: [ST
Sort;
Criteria: | T and bl
ar;

To express AND criteria within a single field use the
AND operator

This filter asks for a State value of TX AND MI.

Field: [ST Rl

To express AND criteria between fields put each

Sork;

criteria on the same row of the criteria grid.

Criteria; [T
ar:

This statement asks for ST equal to TX and Rvol >
90000.

EIA-176 Query System
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- To express OR criteria within a single field use the
Field: [5T
Sart OR operator.
ork:
Criteria: |"Te " Or "MI" .
- This statement asks for ST equal to TX OR Ml
To express OR criteria between multiple fields place
Figld: [5T =T the criteria on separate rows of the criteria grid.
Sort;
Criteriar ["Tw " This statement asks for ST equal to TX or Rvol >
or; I>E||:I|:I|:Il:l 90000.
o |
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3.3.2 - Custom Queries
The Custom Queries option allows you to choose individual data items from the entire EIA-176 for inclusion in

datasets. The methods are similar to those used in the Pre-selected queries.
ZE| Query EI&-176 Data - Query Menu

Query EIA-176 Data

Preselected Query Menu
queries
create files
with
predetermined
EIA-176 items Pre-Selected
Queries

(see notes for available years)

Custom Queries

Custom queries
create

files with EIA-176
items that are
selected from a Ji

Back

L

3.3.2.1 View EIA-176 Company Menu

First you will be prompted to select Companies and Year. This screen is similar to the Company selection
screen in other parts of the query.
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E Query EIA-176 Data - Choose Company(s)

Query EIA-176 Data - Choose EIA-176 Company(s)

. 1998 -
You can Please enter a report year: 1999
select one Choose a retrieval method 2000
or more ggg;
companies ©  Selecta Company in a State ¢ iSelect all Companies 2003
by name : : 2004
or state . ©  Selecta Company by Name 2005
2006
Choose EIA-176 Companies to include in your query 2007
Use the
arrow
buttons to Next == |
selecta
state or
company.
<=Back |

After you've selected companies and the year, you will go onto the Select Reported Data Items button. You’ll be
presented with a list of EIA-176 form data lines to pick from
3.3.2.2 Pick Reported Lines
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5] custom Queries - Select Reported Data Items Each line
User-Selected Queries - for year(s):[2008 item with
Select Reported Data Items data from
the form is
represented
with a short
description.
. The Part
You have Select data items .
selected all and Line
companies 1| Section/ LineNo/ Description - Number is
3 3014 |CNEAF Alternative Fuel Ans1ﬂ also
4 0110 | Gas Produced onsystem by included.
4 0120 | Synthetic natural gas produc The
4 Underground Storage Withd — h|gh|lght
4 0220 @ Received fram LN = | K
4 0230 | Other StoraAvailable data items | method is
4 0300 Transported into rpt ST from: similar to
. = 4 /0400 Receipts at City Gate that in the
4 0500  Other Receipts
;E; 4 0600 |Supplemental Gasous Fuels - Company
K 4 0700 |Total Supply Einished screen.
AL & 0800 |Inventery of LNG Selecting
AR 6 0900 Heat Content of consumer de
Al 6 1010 Del to Residential Sales
:‘F_f 6 1020  Delto Commercial Sales <=Back
6 1030 |Delto Industrial sales
E’: 5 104N Nal tn Flactric | Filibe qqlnc_’lj
co
cT
oe = Note: can not select both line 3.0 and line 14.0 in this function. Results are
—- not predictable. Use the: "Interstate Movements (lines 3.0 and 14.0) - looks

like Table 12" canned query instead.

Once all your selections have been made click Finished Selecting.

3.3.2.3 Select Quantities and Build Calculated Items

The Select Quantities and build Calculated Items screen has three parts.
Aggregate functions
Select Company Available Quantities.

Calculated field.

EIA-176 Query System
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Zgl User Selected Queries - Select Quantities and build Calculated Items - =

Make your type of operations and quantity selections before Add a Calculated
<=Back | clicking Complete. Field => Complete=>
e

4| Aggregate functions Average Al
Count

i Sum h
4 I | 4

[

1 Select a Type of Investor Owned distributor

) Operations Municipalty owned digtributor

(default is All) Privately owned distFetor
Co-op gis#ritfltor LI
Un-check available quafitities to include or exclude quantites  Available Quantities Quantities to include \
'n you custom query in Query Output
Line Num of Hum
Part Number Description Vol Cost Consum Btu Mef g Costof Btu Mcf

JZ [1010 [Del to Residkntial Sales
| Je " [1020 [Del to Commérgial Sales
[6 " [1030] [Del to Industrial shlgs

i i

NS
NS

Available Quantities:

For each line item you select this portion of the screen will have a row.
The Available Quantities portion shows you what quantities are available for this item.
The Quantities to include portion allows you to include or exclude quantities.

For this example, if you aren’t interested in the Number of Consumers for deliveries to

Residential Sales, you would use the mouse to deselect that item, and it won’t appear in your
query data file.
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Type Of Operations

You can select multiple Types of Operations if you choose.

If no selection is made, all types are included. If they are all included they are not identified.
. Aggregate functions

When you
Aggregate functions ’;‘:E;?gs = select
Sum = Aggregate
<] | _'l_I functions
The Aggregate functions provide summary statistics for all the companies selected. The Otr:?r
Aggregate functions, the Type of Operations, and the Add calculated functions are mutually gp lons
exclusive. dg;%rlr;%
I—;_'| User Selected Queries - Select Quantities and build Calculated kems —
<=Back ::.T;I:Eianygog;ggr&e?efloperations and quantity selections before Add T_—igi:{::ﬂatecj Complete=>
Aggregate functions E«;j:gs =
Eum _}lﬂ
Select a Type of Investor Owned distributor ||
Operatians Municipally owned distributor
:default is ‘Q":' Priwatsh_..f u'..'.'nsd distributor
Co-op distbuter =
In the following example the Aggregate function has been grouped by Delivered to Consumers
gzl Dynamic_Query : Select Query The
ST Year SmDIResSalV SmDIResSalC{ SmDIResSalN( [ﬁ:”q'tje?;
| X% 2000 17633864 4266459 5924 with sum
AL 2000 42426740 353524275 70220 aggregate
AR 2000 JR2443801 21571912 254121 func_:tion.
AL 2000 32940263 300781424 02465 Notice
| |CA 2000 Sh457 4535 37 37ERT 351 9318330 LZ?;:::?
| [CO 2000 111748319 BO16R55106 1265032 headers
L [CT 2000 3E3R4174 404416826 4420457 all start
| (DC 2000 13182630 114736865 126714 with Sm —
| |DE 2000 aaRz099 7E480714 1159651 for Sum.
| [FL 2000 13R5852451 158053956 Lt =l A
| GA 2000 584255972 2659730510 aE74380
| [HI 2000 023675 0933534 30708
[ 1A 2000 71408355 435303533 FI5790
Record: 4] ¢ || 1 » |_r_|_|_>*| of 51 1] -
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£ EIA-T76 Ouery Systen |
“ File Edit Catashest Tool

Save AsfExport, .,
o Page Setup...
& Print Prewyiew

Close
Datasheet Wisw
&b Print...
Exit
i :S_l User Selected Queries - Select Quantities and build Calculated lEems

The File menu provides your query output options.
Close — closes the query and returns you to the
selection screen.

When you return to the selection screen your
company, year and data item selections will still be
in place. Any aggregate functions will be cleared.

clicking Complete.

<=Back |

Make your type of operations and quantity selections before

Add a Calculated
Field ==

Complete=> |

Average ‘I

Count

Sum il
[« | _>I_I

Aggregate functions

Inwestor Owned distributor -
Municipally owned distributor
Privatety owened districutor

Co-op diztributor LI

o TR I S

Select a Type of
Operations
(default is All)

V4

Un-check available quantities to include or exclude quantfes
in you custom query

Line
Part Number Description
|E_|101ﬂ [pel to Residential Sales /
IE_I'M-ZD IDeI to Commercial Sales /
[6 " [1030 [Del to Industrial sales /

-

Quantities to include
in Query Qutput

Available Quantities

Num of Num
Vol Cost Consum Btu Mcf  ygl Cosigs Btu Mcf
R RN e o
a o o m e
a3 e E e
IR TR R R

To Add a Calculated F%ake your quantity selections first, and don’t select an Aggregate function. Then

click on the Add a Calc

EIA-176 Query System 11/18/09 -

ated Field button. This opens another window.
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BES User Specified Queries - Build calculated items Choose variables from this list.

User Specified Queries - Build (

Your expression will appear here.

# Click on variables to add
to the expression [F'ﬂLU?DDVDlMCﬂ / ﬂ

[PEL1010valMcf]
Available EIA-176 variables |[PBL1010CStDol]
[FEL1010ConCt]
[PEL1020valMcf]
Use the available variables and th [P 1020CstDal]

column in your query.
Include multiple expressions by [F'EL1DEDCDnCt]

Click on "Finished" to run query. [PEL1030YalMcf] =
When you click on a variable in the
User Specified Queries - Build ¢ Available box, then it will appear in the expression
box.
#1 Click on variables to add ) Click on operators to specify

to the expression

your calculation.

[[PEL10T0VolMeT]

Available EIA-176 variables |[PBL1010CstDol] Y| =Aad
[PEL10T0ConCt]
[PEL1020%olhcf] - | <=Subtract
Use the available variables and tl [PEL1D20CstDal] : —_—
column in your query. [PEL1020ConCt] . ":=Mlll'ti|}|3|'
Include multiple expressions by
Click on "Finished to run query. [PBL1030 ol ;I —
f | <=Divide
[PALO700% olMcf] T ecleft
{ parenthesis
:| <=right
Clear parentheisi
Expression
Box
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[PALO7O0N alicd] + [PEL1010% altcf] Onc,:e
Complete #3 - Complete your expression you ve
Expression built yOL!I’
Clear #4 - Add a1 xpression to expression,
Expression AI;[I(I Anot_her this query. #3 #4 canm CIiCk on
XPression i
= e e omplete
Expression
to finish.
You must name your
, [PALO700N albdcf] + [PELT1010Y ol cf] AS expression in
Complete the Enter a Column
Expression Name box.
Clear 1
Expression Lzl Complete you
Box Expr
Enter a Column Name == ITntall Fion
<=Back {No embedded spaces please!) Run Query

If you want to add another expression click add Another Expression=>,

The expression box will be cleared out and you can start another expression. Your first expression will be
held for the query.

When you are finished, click Finished=> Run Query. This will immediately run the query.

Note: you can click and edit the expression in the expression box.

=% Dynamic_Query : Select Query = [=] X
|| CompanylD ST COMPANYNAWE Year PALO700VolMcf| PEL1010ValMef| | P PE| F| P F | F P P(H TOTAL B
Ldl K3 ABBYYILLE CITY OF 2005 5020 3945 023 422000 8965
| |17EOOCSIA 1A MOULTOM MUN GAS 5Y 2005 17970 16556 120341111000 34526
|| T7EO00341A 1A BEDFORD CITY NATURA 2005 B5112 43278 120451211002 108390
|| 17E00035IL IL TOLDEDO YILLAGE OF 2005 44523 30534 120451133000 75057
|| 17E00036IL IL SIMS WILLAGE OF 2005 9346 7876 2023 411000 16222
|| 17E000371L IL GRAND TOWER CITY OF 2005 14249 10231 2034111000 24480
|| 17E00033I1L IL SHAWNEETOWN MUN C 2005 31256 25218 120341111002 SB474
|| 17E000401L IL PITTSBURG GAS CO 2005 9199 8315 )2 03011000 17514
| |17EOOO41LA LA ABITA SPRINGS NATURZ 2005 46578 27954 120451111002 74532
|| 17E000421L IL NEWY BOSTON MUN GAS 2005 28581 23307 120347111002 52188
| |17E00043IL IL PLEASANT HILL VILLAGE 2005 42048 29211 120451111000 71269
|| 17E000441L IL PAWNEE VILLAGE OF 2005 94319 75695 12035131002 170014
| |17EOO04BGA  GA COLQUITT GAS SYS CIT" 2005 25837 2097 0451111000 28034

17RNNNAT S CAIRM KAT [AS SYS A 14RRNA AAAT77 TR 04507402 0N 199771 Bz

Record: 1| ¢ 1 | mr#] of 2014

The columns have been resized and hidden (by clicking in the column headers) to show the TOTAL variable.
It is the sum of DLResSalVol And DIComSalVol.

Because the columns were edited in the datasheet, this prompt appears after choosing the Close option
from the File Menu. Dynamic_Query is where user selected-queries are temporarily stored. It does
not matter if they are saved or not.
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Query : Select Query

COMPANYNAME Year DIResSalVal |DI DI DIComSalVal | DIC| D) DI D DI
IBYYILLE CITY OF 2000 4427 04 11 824 {13 1 1213 2
QULTOM UM GAS S5 2000 19263 0512 a0 #1411 00 0
EDFORD ClT'\I." NAT GAS (nininl Cand 4 Nl T ATOTO AL T On
JLEDO YILLAGE OF ElA-176 Query System E
M= WILLAGE OF :

' 7
RAND TOWER CITY OF Do you want to zave changes to the layout of querny 'Tiynamic_Huem's

HAWNEETOWN MUN GAS
TTEEURG GAS CO

3ITA SPRINGS MAT GAS &
=W BOSTOM MUN GAS 5Y3 2000 26343 0512 4875/ H#14/1 00 0O

Mo Cancel

After you close the query you're returned to the Select Quantities and build Calculated Items
Menu.

§| User Selected Queries - Select Quantities and build Calculated Hems

Make your type of operations and quantity selections before Add a Calculated
TR clicking Complete. Field => Complete=>
Aggregate functions Average -l
ggreg Count
Sum x
4| | .4
Select a Type of Investor Owned distributor
Operations Municipally owned distributor
(default is All) Privately owned distributor
Co-op distributor j
Un-check available quantities to include or exclude quantites Available Quantities Quantities to include
in you custom query in Query Qutput
Line Num of Num
Part yumber Description Vol Cost Consum Btu Mef  yol Cosiof Biu Mcf
[6[1010 [pel to Residential Sales Fip N [ M » [
|E- I1DZD|DeItoCommercialSales |v_ |v_ |Y_ |_ |_ VM ¥ W [ I
[6 [1030 [Del to Industrial sales | C C e 2 I I A e B
[ - o E N EE I

To run the query you just constructed again you can click Run Query.

Exit returns you to the main queries menu.
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Appendix A — EIA-176 Survey Form
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Appendix B — Pre-Selected Query Items

Query description

Query Memo

Answers to Question in
Part Il about Alternative
Fuel Vehicles

All Respondent Type of
Operations and Sector
ltems.

All Part IV & V ltems
(Volumes)

All Part VI Items
(Volumes, Costs)

All Sector Items
(Volumes, Costs,
Consumers)

All Sector items sorted by
state

Sector Sector Prices
Residential Sector
Volumes - Delivered,
Transported, Total

Company Name
Information

Commercial Sector
Volumes

Detail level Continuation
Lines

Interstate Movement
Lines (3.0 and 14.0)

Industrial Sector Volumes
Footnotes and Associated
Data Values

Sector Vols sorted by
sector

Electric Sector Volumes

Sector Vols ranked
nationally

Vehicle Fuel Volumes
Total Delivered including
176 Electric

Sector Vols ranked by

EIA-176 Query System

This Query has the answers from companies on Part 3.
This data is only available in 2005.

This Query has Part Ill of the form, Types of Operations,
which the associated consumption sector items by
respondent.

This Query has all Part IV & V Volume items.
This Query has all Part VI Volume and Cost items.

All consumption items by part and line number. In an easy
to pivot format for Excel.

This query includes company data sorted by state for lines
10.1 thru 10.4, and 10.6 and lines 11.1 thru 11.4 and 11.6.
Volumes and Number of Consumers are available for all
lines. Costs are only available for lines 10.1 thru 10.4, and
10.6.

Consumption Sector Prices in an easy to pivot format for
multiple years

Residential sector volumes - delivered, transported and
total.

This query includes the Company Name, State of
Operation and the Type of Operations category they
reported.

Commercial sector volumes - delivered, transported and
totals.

This query shows continuation lines with the company
reference for Parts 4 & 5.

This Query shows lines 3.0 and 14.0. It can be pivoted in
Excel to replicated Table 12 from the Natural Gas Annual.
Industrial sector volumes - delivered, transported and
totals.

This query shows data values and associated footnotes
for selected companies.

This query includes company data sorted by sector -
Residential, Commercial, Industrial, Electric, and Vehicle
Fuel . The query includes volumes with delivered and
transported items.

Electric sector prices - delivered, transported, and totals.
This query includes company data sorted by volume
amounts. Consumption delivered to consumer items -
lines 10.1 thru 10.4, and 10.6 are added to consumption
transported items -lines 11.1 thru 11.4 and 11.6 to rank
companies nationally.

Vehicle Fuel Volumes - delivered, transported and totals.

This query has sectors including electric.
This query includes Company data sorted and ranked by

11/18/09 -
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‘ Query description

‘ Query Memo ‘

state

LNG & Underground Gas
Storage

Sector Prices sorted by
sector

Sector Vols for Investor
Owned Distribution
Companies

Sector Vols for
Municipally Owned
Distribution Companies
Sector Vols for Privately
Owned Distribution
Companies

Sector Vols for
Cooperatively Owned
Distribution Companies

Sector Vols for Other
Distribution Companies

Sector Vols for Interstate
Pipelines

Sector Vols for Intrastate
Pipelines

Sector Vols for Storage
Operators

Sector Vols for Synthetic
Natural Gas Plant
Operators

Sector Vols for Producers

Sector Vols for Gathers
Sector Vols for Liquefied
Natural Gas (LNG)
Operators

Sector Vols for Other
Operators

EIA-176 Query System

volume amount by state. Consumption delivered to
consumer items -lines 10.1 thru 10.4, and 10.6- are added
to consumption transported items -lines 11.1 thru 11.4 and
11.6.

This Query has LNG and Underground Storage Injections
& Withdrawals, as well as LNG Inventory at the end of the
year.

This query includes prices for consumption data - lines
10.1 thru 10.4, and 10.6 - only. Costs are not collected for
transported consumption sector.

This query includes only companies who checked A on
Section Il. Type of Operations. It covers lines 10.1 thru
10.4, and 10.6 and lines 11.1 thru 11.4 and 11.6.

This query includes only companies who checked B on
Section Il. Type of Operations. It covers lines 10.1 thru
10.4 and 10.6.

who checked B on Section Il. Type of Operations.

It covers lines 10.1 thru 10.4, and 10.6

and lines 11.1 thru 11.4 and 11.6.

This query includes only companies who checked C on
Section Il. Type of Operations. It covers lines 10.1 thru
10.4, and 10.6 and lines 11.1 thru 11.4 and 11.6.

This query includes only companies who checked D on
Section Il. Type of Operations. It covers lines 10.1 thru
10.4, and 10.6 and lines 11.1 thru 11.4 and 11.6.

This query includes only companies who checked E on
Section Il. Type of Operations. It covers lines 10.1 thru
10.4, and 10.6 and lines 11.1 thru 11.4 and 11.6.

This query includes only companies who checked F on
Section Il. Type of Operations. It covers lines 10.1 thru
10.4, and 10.6 and lines 11.1 thru 11.4 and 11.6.

This query includes only companies who checked G on
Section Il. Type of Operations. It covers lines 10.1 thru
10.4, and 10.6 and lines 11.1 thru 11.4 and 11.6.

This query includes only companies who checked H on
Section Il. Type of Operations. It covers lines 10.1 thru
10.4, and 10.6 and lines 11.1 thru 11.4 and 11.6.

This query includes only companies who checked | on
Section Il. Type of Operations. It covers lines 10.1 thru
10.4, and 10.6 and lines 11.1 thru 11.4 and 11.6.

This query includes only companies who checked J on
Section Il. Type of Operations. It covers lines 10.1 thru
10.4, and 10.6 and lines 11.1 thru 11.4 and 11.6.

This query includes only companies who checked K on
Section Il. Type of Operations. It covers lines 10.1 thru
10.4, and 10.6 and lines 11.1 thru 11.4 and 11.6.

This query includes only companies who checked L on
Section Il. Type of Operations. It covers lines 10.1 thru
10.4, and 10.6 and lines 11.1 thru 11.4 and 11.6.

This query includes only companies who checked M on
Section Il. Type of Operations. It covers lines 10.1 thru
10.4, and 10.6 and lines 11.1 thru 11.4 and 11.6.
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Appendix C — User Selected Query Item names

| UserQueryName | UQPart [UQLin |
Number of Alternative Fuel Vehicles 3 3014
Gas Produced onsystem by company 4 0110
Synthetic natural gas produced 4 0120
Underground Storage Withdrawals 4 0210
Received from LNG 4 0220
Other Storage Withdrawals 4 0230
Transported into rpt ST from: ST or Cntry 4 0300
Receipts at City Gate 4 0400
Other Receipts 4 0500
Supplemental Gasous Fuels 4 0600
Total Supply 4 0700
Inventory of LNG 5 0800
Heat Content of consumer deliveries 6 0900
Del to Residential Sales 6 1010
Del to Commercial Sales 6 1020
Del to Industrial sales 6 1030
Del to Electric Utility Sales 6 1040
Del fo Vehicle Fuel 6 1050
Del to Other (see footnotes for type) 6 1060
Trans to Residential Consumers 6 1110
Trans to Commercial Consumers 6 1120
Trans to Industrial Consumers 6 1130
Trans to Electric Utilities 6 1140
Trans for Vehicle Fuel use 6 1150
Trans to Other (see footnotes for type) 6 1160
Pipeline Compressor Use 6 1210
New Pipeline Fill 6 1220
Distribution Company Use 6 1230
Other (see footnotes for type) 6 1240
Underground Storage Injections 6 1310
Liguefied natural gas (LNG) Injections 6 1320
Other Storage Injections (see footnotes for type) 6 1330
Trans to State Line: Comp ST/Cntry 6 1400
Lease Use 6 1500
Returned to oil and/or gas reservoirs 6 1600
Losses from leaks, migration, damage and/or 6 1700
Other Disp: Distribution Companies 6 1810
Other Disp: Other Pipelines 6 1820
Other Disp: Storage Operators 6 1830
Other Disp: Other (Specify type) 6 1840
Total Disposition 6 1900
Unacc't for gas supply 6 2000
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